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Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice.

Instruction

This TV is provided with interactive functionality through a set-back box (SBB/STB) connected to the TV, and with other TVs in a computer controlled 
system for hotels and other hospitality businesses. 
Interactive : When the TV is powered-up initially, it sends a command to identify the SBB/STB; if identified, theTV switches to ONLINE mode and full 
control is through the SBB/STB.
If the TV is in ONLINE mode, it stops receiving IR(Samsung remote) commands and acts according to interface protocol. 
Stand-Alone: If SBB/STB is not identified, the TV should be switched to STAND-ALONE mode with restricted operation.

Operational Modes

When this TV (in Hotel mode) is operated with a SBB/STB, it is in one of two states 
•	 ONLINE or STAND-ALONE. In the STAND-ALONE state, the TV will act as a Hotel TV, but without active communication. This is to prevent guests 

from trying to cheat the system by disconnecting the SBB/STB. 

Power
ON

Hotel TV

Online Mode
Poll Rate 20/sec

Stand-alone 
ModeHotel Mode On SBB/STB Online if one 

success within 10 attempts

SBB/STB Online-10 
consecutive fails

SBB/STB Status-
Attempt every 
2secs

To set the details for Stand-alone or interactive mode, refer to pages 22-25(Setting the hotel option data : Stand-alone mode and Interactive mode)
•	 Some operations may be restricted to prevents guests from "cheating" the TV system.
•	 No main menu(Interactive mode) or Channel Menu, Plug & Play in Main Menu(Stand-Alone mode)
•	 Limited Volume and Panel key lock or unlock

Still image warning

Avoid displaying still images (like jpeg picture files) or still image element (like TV Program logo, panorama or 4:3 image format, stock or news bar at screen 
bottom etc.) on the screen. Constant displaying of still picture can cause uneven wear of screen phosphor, which will affect image quality. To reduce risk of 
this effect, please follow below recommendations:
•	 Avoid displaying the same TV channel for long periods.
•	 Always try do display any image on full screen, use TV set picture format menu for best possible match.
•	 Reduce brightness and contrast values to minimum required to achieve desired picture quality, exceeded values may speed up the burnout process.
•	 Frequently use all TV features designed to reduce image retention and screen burnout, refer to proper user manual section for details.

Securing the Installation Space

Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation.
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.

 ✎ When using a stand or wall-mount, use parts provided by Samsung Electronics only.
 x If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the product falling.

 ✎ The appearance may differ depending on the product.

Installation with a stand. Installation with a wall-mount.

10 cm10 cm

10 cm

10 cm10 cm

10 cm

10 cm
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Correct Disposal of This Product (Waste Electrical & Electronic Equipment) 
(Applicable in the European Union and other European countries with separate collection 
systems)
This marking on the product, accessories or literature indicates that the product and its electronic 
accessories (e.g. charger, headset, USB cable) should not be disposed of with other household waste 
at the end of their working life. To prevent possible harm to the environment or human health from 
uncontrolled waste disposal, please separate these items from other types of waste and recycle them 
responsibly to promote the sustainable reuse of material resources. Household users should contact either 
the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling. Business users should contact their 
supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product 
(Applicable in the European Union and other European countries with separate battery 
return systems)
This marking on the battery, manual or packaging indicates that the batteries in this product should not 
be disposed of with other household waste at the end of their working life. Where marked, the chemical 
symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium or lead above the reference 
levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm 
to human health or the environment. To protect natural resources and to promote material reuse, please 
separate batteries from other types of waste and recycle them through your local, free battery return 
system.
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Accessories

 ✎ Please make sure the following items are included with your LED TV. If any items are missing, contact your dealer.

 ✎ The items’ colour and shapes may vary depending on the models.

 y Remote Control & Batteries (AAA x 2) 
 y Quick Set up Guide
 y Safety Guide (Not available in all locations)

 y 3 Gender Cables (BN39-01154C/H/F) 
 y Power Cord / Data Cable

 ✎ The stand and stand screw may not be included depending on the model.

 ✎ The Data Cable may not be included depending on the SI Vendor.
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Installing the Stand

Stand Parts

A B

(M4 X L12)C

Stand x 1 Guide Stand x 1 Screws x 8

Follow the steps below to connect the TV to the stand. For more detailed instructions, see the separate 
stand installation guide.

A

B

C
1

3

4

2

C

(Incorrect assembly)

(Correct assembly)

Side View

 ✎ Place a soft cloth over a table to protect the TV, and then 
place the TV on the cloth screen side down.

 ✎ Insert the Stand Guide into the slot on the TV's bottom.

 x4 (M4 X L12) 

Rear

Front

Top View

DO NOT USE 
CHEMICALS

DO NOT USE 
GREASE

DO NOT 
USE OIL

ATTENTION

x4 (M4 X L12) 
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Viewing the Connection Panel

HG32EA670SK
HG40EA670SK
HG46EA670SK

HG32EA670SW
HG40EA670SW
HG46EA670SW

1

2

3

4

5

6

7

8

9 0 ! @ #

 ✎ Whenever you connect an external device to your TV, make sure that power on the unit is turned off.

 ✎ When connecting an external device, match the color of the connection terminal to the cable.

 ✎ NOTE

 • Make sure to distinguish between the front and back of each component when assembling them.

 • Make sure that at least two people lift and move the TV.

 • Stand the product up before you tighten the screws. If you tighten the screws with the TV lying 
down, it may lean to one side when you stand it up.

 [ Do not insert your fingers into the stand base slot of the TV when installing the stand base.
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1 RJP: This port is an RJP (Remote Jack Pack) communication port that enables connecting different devices to additional 
module so as to improve device use convenience.

2 VARIABLE AUDIO OUT: Used for the audio output to the Bathroom speaker. Connect the Bathroom Wall Box and the 
Variable port (RCA). 

3 VOL-CTRL: Used to control the volume of the Bathroom speaker. Connect the Bathroom Wall Box and the VOL-CTRL 
port.

4 USB / CLONING

 – Connector for software upgrades and Contents Home, etc.
 – Service connection.

5 HDMI IN 1(DVI), 2, 3: Connects to the HDMI jack of a device with an HDMI output. 

 ✎ No sound connection is needed for an HDMI to HDMI connection. 

 ✎ Use the HDMI IN 1(DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI 
adapter (DVI to HDMI) for video connection and the PC/DVI AUDIO IN jacks for audio.

6 PC/DVI AUDIO IN: Connect to the audio output jack on your PC.

7 EXT (RGB)

Connector
Input Output

Video Audio (L/R) RGB Video + Audio (L/R)

EXT 0 0 0 Only TV or DTV output is available

 ✎ Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.
8 HEADPHONE JACK

 – Headphones may be connected to the headphone jack on your TV. While the headphones are  connected, the sound 
from the built-in speakers will be disabled

9 HP-ID

0 ANT IN: To view television channels correctly, a signal must be received by the set from one of the following sources. An 
outdoor antenna / A cable television network / A satellite network.

 ✎ For Norway & For Sweden: Equipment which is connected to protective earth through a network plug and/or 
through other equipment connected to earth, and connected to a cable network, may cause risk of fire. To prevent 
this from happening, a galvanic isolator is also installed between the equipment and the cable network when 
connecting the equipment to the cable network.
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! PC IN: Connect to the video output jack on your PC.

Display Modes

Both screen position and size will vary depending on the type of PC monitor and its resolution.
The resolutions in the table are recommended.

 ✎ Optimal resolution is 1920 X 1080 @ 60 Hz. (Only for 40" model)

Mode Resolution
Horizontal Frequency 

(KHz)
Vertical Frequency 

(Hz)
Pixel Clock Frequency

(MHz)
Sync Polarity 

(H / V)

IBM
640 x 350
720 x 400

31,469
31,469 

70,086
70,087 

25,175
28,322

+/-
-/+

MAC
640 x 480
832 x 624
1152 x 870

35,000
49,726
68,681 

66,667
74,551
75,062 

30,240
57,284
100,000 

-/-
-/-
-/-

VESA CVT

720 x 576
1152 x 864
1280 x 720
1280 x 960 

35,910
53,783
56,456
75,231 

59,950
59,959
74,777
74,857 

32,750
81,750
95,750
130,000

-/+
-/+
-/+
-/+

VESA DMT

640 x 480
640 x 480
640 x 480
800 x 600
800 x 600
800 x 600
1024 x 768
1024 x 768
1024 x 768
1152 x 864

1280 x 1024
1280 x 1024
1280 x 720
1280 x 800
1280 x 800
1280 x 960
1360 x 768
1440 x 900
1440 x 900

1680 x 1050

31,469 
37,861 
37,500 
37,879 
48,077 
46,875 
48,363 
56,476 
60,023 
67,500 
63,981 
79,976 
45,000
49,702 
62,795 
60,000 
47,712 
55,935 
70,635 
65,290 

59,940
72,809
75,000
60,317
72,188
75,000
60,004
70,069
75,029 
75,000
60,020
75,025
60,000
59,810
74,934
60,000
60,015
59,887
74,984
59,954

25,175 
31,500 
31,500 
40,000 
50,000 
49,500 
65,000 
75,000 
78,750 
108,000 
108,000 
135,000 
74,250
83,500 
106,500 
108,000 
85,500 
106,500 
136,750 
146,250 

-/-
-/-
-/-
+/+
+/+
+/+
-/-
-/-
+/+
+/+
+/+
+/+
+/+
-/+ 
-/+ 
+/+
+/+
-/+ 
-/+
-/+ 

VESA GTF
1280 x 720 

1280 x 1024
52,500 
74,620 

70,000
70,000

89,040
128,943 

-/+ 
-/-

VESA DMT / 
DTV CEA

1920 x 1080p 67,500 60,000 148,500 +/+

 ✎ When using an HDMI/DVI cable connection, you must use the HDMI IN 1 (DVI) jack.

 ✎ The interlace mode is not supported.

 ✎ The set might operate abnormally if a non-standard video format is selected.

 ✎ Separate and Composite modes are supported. SOG is not supported.
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@ COMPONENT IN

 – Connects Component video / audio.
 – Connect component video cables (optional) to the component jacks ("PR", "PB", "Y") on the rear of your TV and the 

other ends to corresponding component video out jacks on the DVD.
 – If you wish to connect both the Set-Top Box and DVD, you should connect the Set-Top Box to the DVD and connect 

the DVD to the component jacks ("PR", "PB", "Y") on your TV.
 – The PR, PB and Y jacks on your component devices (DVD) are sometimes labeled Y, B-Y and R-Y or Y, Cb and Cr.
 – Connect RCA audio cables (optional) to [R - AUDIO - L] on the rear of the TV set and the other ends to corresponding 

audio out jacks on the DVD.
# DATA

 – Used to support data communication between the TV and the SBB.
 – The TV jack type is RJ-12. 
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Using the TV’s Controller (Panel Key)

TV Controller is a multi directional button that helps navigate without remote control.

 ✎ Some functions which require a PIN code may not be available.

 ✎ The product colour and shape may vary depending on the model. 

 ✎ Exits the menu when pressing the controller more than 1 second.

 ✎ When selecting the function by moving the controller to the up/down/left/right directions, be sure not to press the controller. If you 
press it first, you cannot operate it to move the up/down/left/right directions.

Power on Turns the TV on by pressing the controller in standby mode.

Adjusting the volume Adjusts the volume by moving the controller from side to side when the power is on.

Selecting a channel Selects a channel by moving the controller up and down when the power is on.

Using the function menu Press the controller when the power is on, then the function menu screen appears. If you press it 
again, the function menu screen disappears.

Using the Menu Selects the MENU(m) by moving the controller in the function menu screen. The OSD(On Screen 
Display) of your TV’s feature appears.

Selecting the Source Selects the Source( ) by moving the controller in the function menu screen. The Source list 
screen appears.

Selecting the Contents Home Selects the Contents Home( ) by moving the controller in the function menu screen. The 
Contents Home main screen appears.

Power Off Selects the Power Off(P) to turn the TV off by moving the controller in the function menu screen.

Standby mode
Do not leave your TV in standby mode for long periods of time (when you are away on a holiday, for example). A small amount of electric power 
is still consumed even when the power button is turned off. It is best to unplug the power cord.

Function menu

TV Controller

Remote control sensor

The image is drawn by facing the 
front side of the TV.
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Viewing the Remote Control

 ✎ This is a special remote control for the visually impaired persons and has Braille points on the Power, Channel and 
Volume buttons.

Installing batteries (Battery size: AAA)

 ✎ NOTE

 x Use the remote control within 23 feet from the TV.

 x Bright light may affect the performance of the remote control. Avoid 
using nearby special fluorescent light or neon signs.

 x The colour and shape may vary depending on the model.

 x Remocon button 'HOME' & '3D' is not supported. When press 
those button, TV unit do not give ANY respond.

GUIDE
CLOCK

CH LIST

POWER

HOME
@ TV

CONTENT

ALARM P.SIZE SUBT.

A B C D

DUAL
I-II

HDMI

PRE-CHTTX/MIX

SOURCE

MENU

INFOTOOLS

RETURN EXIT

Turns the TV on and off. Display and select the available video 
sources.

Return to the previous channel. 

Change channels.

Electronic Programme Guide (EPG) display.

Press to display information on the TV 
screen. 
CLOCK: When you press INFO key in 
standby mode, TV screen will display the 
time.

Exit the menu.

HOME : Switch to the HOME screen.
: Turns the 3D image on or off. ( Only for 

LED 6 SERIES )
DUAL f-g: Sound effect selection.
ALARM: Enter the hour you want the TV 
to turn on.
P.SIZE: Choose the picture size.
SUBT.: Displays digital subtitles.

Display the main on-screen menu.

Cut off the sound temporarily.

Have direct access to channels.

Adjust the volume.

Display channel list on the screen.

View the Contents Home.

Quickly select frequently used functions. 

Return to the previous menu.

Buttons in the Channel list, Contents 
Home menu, etc.

Enter the hour your want the TV to turn on.

Use these buttons in the Contents Home.

Select on-screen menu items and change 
menu values.

Alternately selects Teletext, Double or Mix.

Selects the HDMI mode directly.
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Connecting the TV with SBB

HG32EA670SK
HG40EA670SK
HG46EA670SK

HG32EA670SW
HG40EA670SW
HG46EA670SW

ETH MODEM  Data Cable

TV Rear Panel

Hotel Server 
STB(Set Top Box) or 
SBB(Set Back Box)

1. Connect the DATA jack of the TV to the [ETH MODEM] jack of the STB(SBB) with the Data cable.

 ✎ Use data communication.
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 ¦ List of Vendors and Compatible Data Cables Supplied with the TV

 y Confirm you are using the correct data cable for your vendor. Refer to the code label on the data cables.
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Connecting the Bathroom Speakers

You can connect the Bathroom Speakers in the following method.

 ¦ Connecting through the Variable Output (available without an external amplifier)

1. Connect the VARIABLE AUDIO OUT port of the TV to the Bathroom Wall Speakers of the hotel.

Speaker +

Speaker - N/C

2. Connect the VOL-CTRL jack of the TV to the Volume Control Box Switch port on the Bathroom Wall of the hotel.

 ✎ The maximum speaker output is 4W, 8Ω.

 y Installing the Volume Control
 – If you configure the Volume Control Box as shown in the figure, you can control the volume of the bathroom speakers.
 – The jack that is connected from the Volume Control Box to the TV is a 3.5mm normal Phone jack.
 – Volume Control Box switch consists of Tact switch.

 ✎ Setting the Sub AMP Mode

 – 0: Turns the Sub AMP function off (PWM off).
 – 1: Determines the Sub volume according to the main volume control. That is, the sub volume is determined according 

to the Power On Volume, the Min Volume, and the Max Volume values of the Hotel Mode.
 – 2: Determines the volume according to the bathroom control panel setting.

VOL+

VOL-

TV Rear Panel

Volume Control Box

Speaker

2

1



15English

 y Variable Output Port Specifications
 – Speaker Wire: Use speaker cable no more than 82 feet (25m) in length.

Volume Control Box

VOL - DOWN
( White 1 )

VOL - UP
( Black /Red 2 )

GND
( Shield Wire 3 )

VOL +

VOL -

1

2

3

 ¦ Connect through the Fixed Output (available without an external amplifier)

1. Connect the AUDIO OUT port of the TV and the Audio In port of the audio amplifier with a stereo cable.

TV Rear Panel

Audio Amplifier

1  Stereo cable
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 ¦ Audio Loop In

An additionally created Headphone Box can be installed on a bed or business desk so that users can use it conveniently. The 
installation procedures are given below.

 y Detailed Drawing of the Headphone Box.

HEADPHON BOX

TV Headphones jack

Whitewire (Audio-L)

Shield Wire 

TV HP-ID jack

Red wire + White wire

Red Wire (Audio-R)

Shield wire

TV Rear Panel

Headphone Box
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Connecting the MediaHub HD

Output of any external source connected to MediaHub HD on hotel desk.

1. Connect the RJP port of the TV and the RS/232 port of the MediaHub HD.

2. Connect the HDMI IN (1(DVI) or 2) port of the TV and the HDMI port of the MediaHub HD.

 y MediaHub HD
 – The MediaHub HD is a hardware module that has different Audio Video inputs (A/V, Audio, PC, HDMI and USB) and 

corresponding outputs. The corresponding output sources are connected from MediaHub to TV. The MediaHub 
communicates with the TV via RS232. Hot Plug & Play is a function that allows hotel guests to connect an external 
source to the MediaHub. The MediaHub communicates with the TV by sending messages regarding Active/Inactive 
sources. The TV will switch to the Active external source.

 – You have to connect the HDMI of the MediaHub to the HDMI IN 1(DVI) port of the TV.
 – When the TV is on, connect the TV and the RJP within 10 seconds.

 y Special features
 – PIP
 – Auto Detection

HDMIUSBRS/232

TV Rear Panel

MediaHub HD Rear

2  HDMI cable

1  RS-232 Data Cable
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Connecting the RJP (Remote Jack Pack)

Output of any external source connected to RJP on hotel desk.

1. Connect the PC IN / PC/DVI AUDIO IN port of the TV to the PC/AUDIO port of the RJP.

2. Connect the AV IN [VIDEO]/[L-AUDIO-R] port of the TV to the VIDEO port of the RJP.

3. Connect the AV IN [VIDEO] port of the TV to the VIDEO port of the RJP.

4. Connect the HDMI IN (1(DVI), 2 or 3) port of the TV and the HDMI port of the RJP.

5. Connect the RJP port of the TV and the RS/232 port of the RJP.

 ✎ The RJP (Remote Jack Pack) compatible with this Samsung TV is TeleAdapt TA-7610, TA-7650 (HD) and TA-7660 
(HD Plus).

USB HDMI VIDEO AUDIO AUDIO/PC

RS/232

R W Y

TV Rear Panel

RJP Rear

5

1  D-sub / PC Audio cable

2  Audio Cable

3 Video Cable

4  HDMI cable

Red White Yellow
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 y RJP (Remote Jack Pack): RJP stands for Remote Jack Pack. The RJP is a hardware module that has different Audio 
Video inputs (A/V, Audio, PC and HDMI) and corresponding outputs. The corresponding output sources are connected 
from RJP to TV. The RJP communicates with the TV via RS232. Hot Plug & Play is a function that allows hotel guests 
to connect an external source to the RJP. The RJP communicates with the TV by sending messages regarding Active/
Inactive sources. The TV will switch to the Active external source according to the priority set by the User. 

 ✎ You can select HDMI IN (1(DVI), 2 or 3) and AV IN for connecting RJP. 

 ✎ When the TV is on, connect the TV and the RJP within 10 seconds.

 y The RJP can be returned to the factory default settings by pressing the A/V and HDMI buttons simultaneously for 10 
seconds. All LEDs blink 5 times to Acknowledge that the rest has been performed.

 y The RJP will automatically turn off any LEDs after 5 minutes to avoid unnecessary light pollution in the hotel room. The 
LEDs that were turned off will turn on again if the guest touches any of the buttons and the 5 minute timer will restart. If the 
guest then touches another source button, the TV will change to the selected source and the corresponding LED will be lit.

 y After an RJP Reset or a TV Power OFF/ON, it takes approx. 10 seconds to establish communications between the TV and 
the RJP.

 y The following table shows the approximate time in seconds to switch from the TV to the input source, based on the 
priority. 

 ✎ Scenario 1: When no inputs are connected.

Source To Connect

AV 2 Sec
PC 0.7 Sec

HDMI 3.9 Sec

 ✎ Scenario 2: When two or more inputs are connected and an Input source is disconnected and then reconnected.

Source Disconnect To Connect Total

AV 4.5 Sec 2 Sec 6.5 Sec
PC 0.7 Sec 0.7 Sec 1.4 Sec

HDMI 3.9 Sec 3.9 Sec 7.8 Sec

 ✎ E.g. If the RJP has all its live sources AV, PC and HDMI connected, AV is viewed as the highest priority. If the RJP is 
in HDMI mode, and a guest removes and reconnects the AV, the minimum time required to switch to the AV is 6.5 
seconds.

 y To connect audio (Ipod or Mp3), Music mode should be ON and Jack Ident detect should be OFF.
 y A/V, PC and HDMI input sources are supported.
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Setting the Hotel Option Data

To Enter: Press the MUTE → 1 → 1 → 9 → ENTERE buttons in order. (From the Hospitality mode, the Standalone mode is set.)

To Exit from this menu : power off and turn on again.

No
Hotel TV Function

Description
Category initial value

1 Hospitality Mode - Standalone Select the Hotel TV mode. (Standalone / Interactive)

2 SI Vendor - OFF Select the SI Vendor

3 Power On

Power On 
Channel EN

User Defined TV will turn on to particular Channel.

Power On 
Channel

1 TV will turn on to this particular Channel.

Channel Type ATV

Provides channel Type description for Power On channel 
selected. i.e.
Selected channel analog or Digital & antannae selection(Air or 
Cable).

Power On 
Volume EN

User Defined TV will turn on with this Volume Level.

Power On 
Volume

10 TV will turn on with this Volume Level.

Min Volume 0 Minimum Volume Level setting user can set

Max Volume 100 Maximum Volume Level setting user can set

Power on 
source

TV Select the Input source when TV is turned on initially.

Power On 
Option

Last Option

Power On(AC Power On) Option
- STN-BY : Stand-By Mode
- Power On : Power On
- LAST OPT : Last Power State

4 Channel

Channel Setup - User can set channel option. 
Such as Auto Tunning, Manual Tunning, Antenna setting.

Channel Editor -
Provided option for editing Channel Name and Number and 
video.
Mute settings for channels in channel List.

Mixed Channel 
Map

OFF Mix Analogue and Digital Channels

Dynamic SI OFF

On : No Check of the DTV Program channel number.(DTV 
channel editor accessible, but addtional channel Program 
number update not supported)
Off : Check the DTV Program channel number. (DTV channel 
editor inaccessible)

CH Rescan 
MSG

ON

This is a display option for the OSD text that appears when 
a user configures the country specifications in hotel models. 
This option determines whether to activate the items that 
are only executed after a manual user confirmation when 
the notification message is displayed while the country 
specifications are being configured.
On - When TV has an event for setting change because of 
country spec, It will be shown on the screen.
Off - Even TV has an event for setting change, because of 
country spec, it will not be shown on the screen.

Pan Euro MHEG OFF

If Pan EURO MHEG is set to On, MHEG is On regardless of 
the product specifications or region. (Even if the region does 
not support MHEG, it is supported in case the hotel supports 
MHEG.)
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No
Hotel TV Function

Description
Category initial value

5 My Channel
My channel En OFF Set the My channel function ON/OFF.

Genre Editor User can set the genre for searched channel.

6 Menu OSD

Picture Menu 
Lock

OFF
Provided option for editing Channel Name and Number and 
video.
Mute settings for channels in channel List.

Menu display ON
- On : Main Menu display
- Off : Main Menu No display

7 Operation

Panel Button 
Lock

Unlock

Front panel(Local key) operation on/off
- Unlock: Unlock All panel key
- Lock: Lock All panel key
- OnlyPower : Lock All panel key except Power panel key

Subtitle Auto On Off/On Set the automatically subtitle on function when user set the 
nation to France.

8 Clock

SW Clock Off/On
Set the S/W Clock function On/Off.
- TV displays the current time when the user pushs Info Key of 
the remote control in Stand-by mode.

Local time Manual

Selection of the way to update clock data
- Manual: Use clock data from DVB channel or manual clock 
setting When the TV is in the stand-alone mode.
- TTX: manual clock setting (with updating from TTX data).

9 Music Mode

Music Mode AV OFF
To get music output from mp3/audio player in AV Input 
Source. 
Audio enabled, video disabled in this mode

Music Mode PC OFF
To get music output from mp3/audio player in PC Input 
Source. 
Audio enabled, video disabled in this mode.

Music Mode 
Comp

OFF To get music output from mp3/audio player in Component 
Input Source. Audio enabled, video disabled in this mode

Music Mode 
Backlight

OFF Backlight On/Off option in Music mode to save energy

10 External Device

RJP(7610) 
Priority AV

1
If the jack priority is set, the corresponding source is 
automatically set when a jack is inserted according to the jack 
priority

RJP(7610) 
Priority PC

2
If the jack priority is set, the corresponding source is 
automatically set when a jack is inserted according to the jack 
priority.

RJP(7610) 
Priority HDMI

3
If the jack priority is set, the corresponding source is 
automatically set when a jack is inserted according to the jack 
priority.

RJP(7610) AV 
Option

AV1 Select RJP AV Source (AV1).

RJP HDMI 
Option

HDMI1 Select RJP HDMI Source (HDMI1/HDMI2/HDMI3).

Sound Bar Out OFF ON / OFF sound bar out.
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No
Hotel TV Function

Description
Category initial value

11 External Source

USB Media 
Mode

Default Control Pop-Up menu at USB insert to TV.

External Source 
Banner

Enable/Disable

Users can set External Source Banner to On or Off.
On : When TV power On or Mode changed, TV will disply the 
external source banner.
Off : When TV power On or Mode changed, TV will not disply 
the external source banner.

Auto Source OFF While TV is in power on state, if PC source is connected to TV, 
TV will automatically switch to PC mode.

Anynet+ Return 
Source

Power On 
Src….

Set the return source after closing Anynet+.

12 Bathroom Speaker

Sub AMP 
volume

13 Sub AMP Volume level at power on initial condition.

Sub AMP mode 2

Determines the Sub AMP operation mode.
- 0: Turns the Sub AMP function off (PWM off).
- 1: Determines the Sub volume according to the main volume 
control.
That is, the sub volume is determined according to the Power 
On Volume, the Min Volume, and the Max 
- 2: Determines the volume according to the bathroom control 
panel setting.

13 Eco Solution Energy Saving Off

This feature adjusts the brightness of the TV in order to reduce 
power consumption.
- Off: Turns off the energy saving function.
- Low: Sets the TV to low energy saving mode.
- Medium: Sets the TV to medium energy saving mode.
- High: Sets the TV to high energy saving mode.
- Auto: Sets the TV to automatically energy saving mode.

14 Logo/Message

Welcome 
message

OFF Display Welcome Message.

Edit Welcome 
Message

Edit Welcome Message.

Hospitality Logo OFF Use can set the logo display Off or the type of logo file (BMP/
AVI).

Hospitality Logo 
DL

- Download the logo file from USB toTV.

Logo Display 
Time

5 Seconds Set the logo display time.

15 Cloning

Clone TV to 
USB

- USB Clone: TV → USB

Clone USB 
to TV

- USB Clone: USB → TV

Setting Auto 
Initialize

OFF

When Setting Auto Initialize is set to On, and the power is 
turned off and on or the Master Power is turned off and on, the 
data is restored to the cloned values.
If there is no cloned value, even when the Setting Auto Initialize 
is set to On, it will be ignored and the operation will be the 
same as that whenSetting Auto Initialize is set to Off
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No
Hotel TV Function

Description
Category initial value

16 SIRCH

SIRCH Update 
Time

1hour Standby SIRCH will be operated, according to time setting

SIRCH Update 
Immediate

OFF Make TV operate SIRCH after 1 minute in Stand-by mode.

Manual SIRCH - Make TV operate SIRCH by manually

SIRCH Channel 87
Set the default channel for SIRCH
- None : After Auto Scan, Operate SIRCH
- Channel valuew : Operate SIRCH at the channel selected

SIRCH Version 0 Display SIRCH version of TV

SIRCH Group ID All Provided SIRCH ID for operating SIRCH on a specific set.

REACH OFF Set whether to use REACH function.

17 SERVICE

Self Diagnosis

Enter Self Diagnosis Menu.
Picture Test: Use to check for picture problems. If the problem 
appears in the test picture, select Yes and follow the directions 
on the screen.
Sound Test: Use the built-in melody sound to check for sound 
problems. If the problem occurs during the test, select Yes and 
follow the directions on the screen.

SW Upgrade SW USB Update function

Service Pattern Same function with SVC Service Pattern 

TV Reset Factory reset



24 English

 ¦ Welcome Message

Welcome message is a feature to display custom message on TV, every time TV is turned on by Guest in Hotel room. 
 – Welcome message settings are placed in Hotel Option Menu.
 – Welcome message should be ON in order to display the message on power on. 

Hospitality Mode Standalone SIRCH

SI Vendor OFF Service

Power On

Channel

My Channel

Menu OSD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cloning

r

Welcome Message ON

Edit Welcome Message

Hospitality Logo ON

Hospitality Logo DL ...

Logo Display Time ...

 – Welcome message can be of 25 characters and it can be edited by changing its text in Hotel Service menu.
 – Following is the list of characters supported for Welcome message:

 ✎ In letters from A to Z only in capital letters is allowed.

 – Welcome message can be edited by using navigation, color & enter key of a Remote in “Edit Welcome Message” OSD. 

 Move          Enter          Return

_

 
 

Move to Left

Move to Right

Level Black

Done

A B C D E F G

H I J K L M N

O P Q R S T U

V W X Y Z

W E L C O M E

Edit Welcome Message

A

B

C

D

 – Welcome message and hotel logo cannot be active at the same time.
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 ¦ Hotel Logo

The Hospitality Logo function displays the Hotel's picture image when the TV is powered on.
 – Hospitality Logo settings are in the Hospitality mode menus.
 – The Logo Download and Logo Display Menu items are enabled when you turn the Hospitality Logo option on.
 – If there is a logo image stored in the memory and Hospitality Logo option is on, the Hospitality logo is displayed when 

the TV is turned on. 
 – The Hospitality logo is not displayed when the Hospitality Logo option is off, even if the logo image has been loaded into 

the TV.

Hospitality Mode Standalone SIRCH

SI Vendor OFF Service

Power On

Channel

My Channel

Menu OSD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cloning

  

r

Welcome Message OFF

Edit Welcome Message

Hospitality Logo BMP

Hospitality Logo DL

Logo Display Time 5 Second

 y Hospitality Logo
 – This option lets you choose whether the Hospitality Logo image is displayed or not.
 – Initial value is OFF.
 – Can be set to OFF or ON.
 – When set to ON, the Logo Download and Logo Time Display menu items become accessible.

 y Hospitality Logo DL
 – This option lets you download the logo image to the TV’s memory from a USB device.
 – Wait appears while the image is being copied to the TV.
 – Completed appears when the copy operation has finished successfully.
 – Failed appears when the copy operation was unsuccessful.
 – No USB appears if no USB device is connected.
 – No File appears if there is no file to copy on the USB device or or the file is in the wrong format (must be a BMP file). If 

No File appears and you have a logo file on the USB device, check the file format.

 y Logo File Format
 – The TV supports only the BMP and AVI format.
 – The file name must be samsung.bmp or samsung.avi.
 – The maximum resolution of the BMP format is 960 x 540.
 – The maximum fi le size of AVI format is 30MB.
 – The TV does not change the size or scale of the image.
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 ¦ Cloning

USB Cloning is a function to download user configured settings (Picture, Sound, Input, Channel, Setup, and Hotel Setup) 
from one TV set and upload the same to other TV sets.
All the user-defined settings from the TV (Master Set) can be copied to the USB device.

 y Clone TV to USB: It is an operation to copy the stored data from the specific area on the 
EEPROM from the TV set to the USB device.

1. Insert a USB drive into the USB port on the rear of the TV.

2. Enter the Interactive menu by pressing this buttons in order. 

 x MUTE → 1 → 1 → 9 → ENTER

3. Press the ▲ or ▼ button to select “Clone:TV to USB”, then press the ENTER button.

4. The message “Clone:TV to USB” is displayed, then press the ENTER button.

5. You can Make sure USB cloning behavior.

 x In Progress: during copying data to USB.

 x Completed: copy operation was finished successfully.

 x Failed: copy operation was not finished successfully.

 x No USB: any USB is not connected.

 y Clone USB to TV: It is an operation to download the stored data in USB device to TV 
set.

1. Insert a USB drive into the USB port on the rear of the TV.

2. Enter the Interactive menu by pressing this buttons in order. MUTE → 1 → 1 → 9 → 
ENTER

3. Press the ▲ or ▼ button to select “Clone:USB to TV”, then press the ENTER 
button.

4. The message “Clone:USB to TV” is displayed, then press the ENTER button.

5. You can Make sure USB cloning behavior.

 x In Progress: during copying data to TV.

 x Completed: copy operation was finished successfully.

 x Failed: copy operation was not finished successfully.

 x No USB: any USB is not connected.

 x No File: there is no file to copy in USB.

 ✎ The operation to copy from USB to TV can be executed by pressing ENTER key for 5 seconds.

 ✎ The Hotel TV product family does not support the CLONE function between a model that supports the satellite / T2 
operation and a model that does not.

For fast instant cloning during installation!
Insert USB key with master settings from first TV and press Enter key for 5 seconds.

Logo/Message

Cloning

d

Clone TV to USB

Clone USB to TV

Setting Auto Initialize OFF

Logo/Message

Cloning

d

Clone TV to USB

Clone USB to TV

Setting Auto Initialize OFF
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 ¦ Plug & Play

Hotel Plug & Play is a function that automatically performs the Hotel mode selection, Country Setup, Clock Setup and Picture 
mode Setup once.

 – Hotel Plug & Play is available only one time when power is first turned ON.
 – After setting up first TV and Clone TV to USB
 – Next TV only needs to exit Hotel Plug & Play, connect USB, then Clone USB to TV.

E E

E

If Standalone Only is selected

TV will enter the RF mode.Standalone mode 
is set.

If Standalone Plug & Play 
is selected

<Depending on Region, this step may not exist.>

E

E

After Searching the channels.

Easy Set up

Next

After Plug & Play is 
completed, TV will be set 
to standalone mode.

Setup > Start

● Interactive

● Standalone Plug & Play

● Standalone Only

Select the language you want to use.

Next

Select English as the 
menu language.

Setup > Menu Language

● Hrvatski

● Čeština

● Dansk

● Nederlands

● English

Select Country.

Next

Previous

Set the country to United 
Kingdom.

Setup > Country

● Serbia

● Slovakia

● Slovenia

● Switzerland

● United Kingdom

Let's find and store channels on your 
TV. How do you receive programming?

Next

Skip

Previous

Selecting Aerial cable 
means all the channels 
available through your 
RF cable will be stored. 
(Auto Tuning 
necessary)

Setup > Auto Tuning (1/5)

● I use an aerial cable.

● I use a cable or satellite service.

Set Auto Tuning search options.

Digital & 

Analogue
Digital Analogue

Air ● ● ●

Cable ● ● ●

Next

Skip

Previous

Setup > Auto Tuning (2/5)

Set the Clock Mode. Set the current time 
automatically using the 
time from the digital 
broadcast.

Select Picture Mode.

Next

Skip

Next

Previous

Previous

Setup > Clock (1/2)

Setup > Picture Mode

● Auto

● Dynamic

● Manual

● Standard

-  After selecting the country in the country menu, 
some models may proceed with an additional 
option to setup the pin number. 

-  If you forget the PIN code, in the Hotel menu, 
select the SERVICE -> TV Reset. And set the 
pin code again in the Plug & Play.
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 y Plug & Play OSD
 – Initial Highlight: Interactive
 – If Standalone Only button is selected, the Standalone hotel mode is set by default and “Standalone mode is set” OSD is 

displayed for 3 seconds.
 – TV enters into RF mode automatically after displaying “Standalone mode is set” OSD for 3 seconds.
 – When Interactive mode is selected, Interactive Setup Menu is displayed. Press power off button to exit from Interactive 

menu.
 – When Standalone Plug & Play mode is selected, “Select Menu Language” OSD is displayed.

 y Select Menu Language OSD
 – When Standalone Plug & Play is selected from “Easy Set Up” OSD, “Select Menu Language” OSD is displayed.
 – Initial Highlight : English
 – Display time: OSD timeout and operation are the same as Samsung's consumer TV models.
 – If ENTER button is pressed, “Select Area” OSD is displayed.

 y Select Country
 – Initial Highlight: United Kingdom.
 – The Country OSD is displayed and the area can be selected.

 y Clock setting OSD
 – Display time: 30 seconds.
 – The Clock Set item OSD is displayed
 – If ENTER button is pressed after setting the clock or in Auto, Picture Mode OSD is displayed.

 y Auto Search Mode OSD
 – If skip option is selected, it goes to Clock setting OSD.
 – If ENTER button is pressed, auto searching of channels is performed.
 – The OSD Display time, which is from the time that Auto Store is started to the time that Auto Sort is completed, is 30 

seconds.

 y Picture Mode OSD
 – Initial Highlight: Standard.
 – The Picture Mode OSD is displayed and the Dynamic or a Standard Picture mode can be selected.
 – After selecting the picture mode, it enters Standalone Setup Menu OSD, press power off to exit.
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SIRCH

 y Introduction
SIRCH (Samsung Interactive Remote Control for Hospitality) is a professional interactive remote controller for DTV that 
lets you deliver TV firmware updates, cloning data, and channel mapping changes to several hundred hospitality TVs 
simultaneously. Mounted at the broadcast head-end system in hotels, motels, resorts, hospitals, and apartment buildings, it 
delivers modulated RF control signals to hospitality sets in each guest room through coax cable. 
SIRCH includes PC embedded systems and cable RF modulators which have DVB-C (Europe) and OpenCable (North 
America) RF output. It also has a 40GB Solid State hard drive, and a 100/1000 Base-T Ethernet port which lets you load TV 
firmware updates. 

 ✎ SIRCH is sold separately.

 y  System Block Diagram (eg. Headend System in Hotel)

SIRCH

Headend System for Hotel

HD ENCODULATOR

HD ENCODULATOR

HD ENCODULATOR

HD ENCODULATOR

Satellite Receiver

Independence AV Stream

Cable STB

Terrestrial Receiver R
F 

C
om

bi
ne

r

 y Features
 – SIRCH Windows Application SW
 – 19 inch Rack Unit type, PC embedded Modulator : OpenCable.
 – Remote Upgrade (TV Software, Cloning Data, Channel Map)
 – Operation can be controlled by key button, extra key board, monitor, and mouse.
 – Low Phase noise, High MER, 50~870MHz, +7 ~ -30dBm RF output.

 y Cautions
 – SIRCH can operate only in TV RF mode. (OpenCable QAM Modulation).
 – You can install SIRCH only on TVs in the stand-alone mode. (Power On Source should be TV).
 – SIRCH operates only when the SIRCH application version is higher than the TV’s SIRCH version.
 – You must check the SIRCH application version to ensure it is compatible with the TV firmware version.
 – The SIRCH function is not supported for satellite channels. 

(To use the SIRCH function in satellite models, make sure to set the Power On Channel to an Air or Cable channel.)
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 y SIRCH operating Diagram

Coax.
Cable

RFTCP/IP

(Windows 
Remote Access)

Hotel Installer can edit the Install Menu/
Channel Map data using the SIRCH 
windows application program.

You can updated all hospitality TVs in an 
entire installation.
This includes delivering TV firmware, 
channel mapping, and settings.

 y SIRCH Installation Considerations

There are a number of factors and operations you need to consider when you set up and run SIRCH:
1. Set the SIRCH Update Time

-Normally, you would use Standby SIRCH. Standby SIRCH updates TVs when they have been in Standby mode for a 
certain length of time or when they are in Standby mode at a certain time every day.
-You can set the standby SIRCH value  to Off, 1Hour, 2Hour, 12:00 PM, 02:00 PM, 12:00 AM, or 02:00 AM.
-The default value is 1Hour.
-When you select “1Hour” or ”2Hour”, 1 or 2 hours after a TV goes into Standby mode, the SIRCH upgrade starts 
automatically.
-If you select a specific time setting, the Standby SIRCH is performed once a day at the defined time.

2. Set the SIRCH Channel

-Use SIRCH Channel to set the PID frequency that willl carry the SIRCH parameters to the TVs in the system.
-Open Cable : You can use CH2 through CH135.
-A detailed frequency table is available in the SIRCH Windows Application Program User's Manual.

3. Verify the SIRCH Version

-The SIRCH version at the headend must be a higher version than the version on the TVs for the TVs to update.
-For example, if the software version in the SIRCH PC application is 01a0, then the current TV SIRCH version on a TV 
must be less than this for the TV to update. 
-The software version value updates to a higher value automatically each time a change is implemented.
-The software version value for the TV clone data must be in hexadecimal format.

4. Test using Manual SIRCH 

-Plan to use Manual SIRCH to test whether SIRCH has been installed properly.

 ✎ NOTE

 x Please visit www.lumantek.com/sirch/ for more information.

 x  SIRCH Windows Application Program User's Manual is available at http://www.samsung.com/us/business/
hospitality.
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 ¦ GENERAL INFORMATION

 y System Overview
The ‘Samsung Interactive Remote Control for Hospitality (SIRCH)’ application is a Remote Control Update system for the 
better and cost effective service to Hospitality industries. This will allow user/operator to configure the guest TV with RF 
distributing system. Application will help user to set and configure the guest room TV Set parameter. The created setting 
file will get used by SRCUS for configuration of guest TV.
Application is intended to create or modify clone files for user and to update guest TV with these clone files by transmitting 
them with RF. Application provides a user interface similar in appearance to TV’s parameter settings where user can 
update factory menu settings and can modify or tune channels to update guest TVs.
To effectively complete and support the requirements of the “Hospitality” Industry, a management system is needed that 
will allow the operator to have control of the TV sets in the guest’s room without requiring a potential disruptive or costly 
visit to each room
 – Channel Configuration Made Easy All from the Head End FMA System.
 – Will configure and deliver the channel line-up and SW upgrade to the guest room terminals via the hotel’s 

coaxial distribution.
This application is an S/W utility to configure user configuration parameter defined below:
 – Hotel Factory Menu (Standalone Menu/Interactive Menu)
 – Channel map

It also supports generation of TS stream embedding clone file information and control of the modulator which is used for 
broadcast of TS stream.

 y Purpose of the Document 
This document is prepared to facilitate and guide the user how to create/modify clone files, to update interactive/
standalone menu settings, to configure channel map and to create TS stream using SIRCH. Screens-wise explanations 
are provided here in this document in the process flow of the application.
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 ¦ GETTING STARTED

 y Installation instructions for Windows XP/Vista/2007

1. To install Samsung Interactive Remote Control for Hospitality (SIRCH), locate 
and open the setup directory of SIRCH and double-click on the file “setup.
exe”. 

2. Click on Next Button to proceed for Installation wizard of SIRCH.

3. Read the license agreement carefully and select “I accept the terms in the 
license agreement” and click on Next button.

4. Please enter User and Organization information and click on Next to 
proceed.

5. Click Next to install the application files to the default folder, or click Change 
to install to a different folder.
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6. Choose the setup type (Complete / Custom) that best suits your needs. 
Complete is recommended for users as it will install all program features.

7. The wizard is ready to begin installation. Click on Install to begin the 
installation.

8. After installation process completes, Click Finish to exit the wizard.

9. After clicking on finish a desktop icon is made for launching SIRCH 
application and also it is added in your Start Menu → Programs.

 y Launching/Starting SIRCH Application

1. To launch SIRCH, either user can double-click on the icon made 
on desktop named “SIRCH.exe” or user can go to Start Menu → 
Programs → Samsung → SIRCH → SIRCH.exe.

2. Application will launch a window asking to select Mode and Model to 
proceed.

3. User can choose options form File Menu to proceed to his specific 
application requirement.

 y Uninstalling SIRCH Application

1. To uninstall SIRCH go to StartMenu → Programs → Samsung → SIRCH → Uninstall.exe.

2. Follow the steps of uninstall wizard.
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 y Create New Clone Files

After launching SIRCH, application will show a window asking for Model and Mode selection. Application starts with the 
utility to create new clone files thus other utilities can be called from File Menu. To create new files user may follow the 
following steps:

1. To create new file, either launch SIRCH.exe or choose Create New 
File from File Menu.

2. Select series, region, LCD/LED type of the model from the drop down 
boxes.  
If user doesn’t know the series,region or type of the model, he can 
select “All”.

3. Selecting Region, Series and type will filter out the Models in 
Modelno. Dropdown box.

4. Select TV Model from the drop down box in front of “Model” Option.

5. After selecting Model no. S/w name of the model will shown in S/W name box.

6. Click on Proceed button.

Select Model’s Series, 
Region, LCD/LED 

Select TV Model 
Software Name for 
selected TV Model 
appears
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 y Modify existing Clone files

To modify the existing clone files user must follow the following steps:

1. Go to File Menu → Load from file. If the option is disabled user 
is probably on the next screen so he must come back to main 
screen by clicking back button.

2. After clicking on Load from file, a browser window will open 
which will ask user to locate clone file folder. User must locate 
the immediate parent folder of the files not the folder named with 
version no.

3. After locating files click on OK. 

4. Model no, Region, Series, Type and S/w name will be uploaded 
from clone files and made visible to user. Though user is not 
allowed to change them.

5. Click on Proceed button.

6. All Hospitality option menu settings and channels in channel map 
will be loaded from the files. User can change them and can save 
or overwrite.
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 y Hospitality Options Setting

After clicking “Proceed” button, application will navigate user to next screen with different tabs (Hospitality Options, 
channel map and generate). User can navigate to other Tabs , this will not lead to any  loss of unsaved data. 
 To modify factory menu settings user may follow the following steps:

1. Select Hospitality Options Tab.

2. Application will show Blue labels and drop down boxes in front of 
each labels which have their different values.

3. User may select any value from the drop down box to change 
some parameter.

4. Default values are selected are shown according to that particular 
TV Model’s default settings, if user doesn’t make changes.

5. Dark and Dim labels are the parameter which user cannot change 
and are disabled.

6. To set logo user can click on logo Download which will navigate him to a file browser window.

7. User should Click save button only when all settings are done including Channel Map settings because save button 
will generate Clone files. Thus user should not confuse himself that there is different save button for every Tab.

Hospitality Option 
TAB

Disabled Parameters

Drop Down Box 
to change default 

values  
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 y Channel Map Configuration

Channel Map tab shows a list of channels in a table where for every channel, channel name, PTC no., Program No., 
Modulation and Program Type are shown. Channel map information is only configured for English language. Though 
channel names in any other language in clone file loaded from TV will remain undisturbed after changes from SIRCH 
application. Channel category is a list of options for Air, Cable, Satellite and All, at left of the table. All is selected as default, 
which shows every channel existing in the map. By selecting Analog or Digital user can filter channel list in the table. User 
can add a new channel, edit existing channel in list or delete it by clicking on add, edit and delete buttons respectively. Edit 
Button also shows complete information for a channel in the list which can modified by user.

 y Add a New Channel

To add a new channel user must follow following steps:

1. Select Air, Cable or Satellite whichever type of channel user wants to add.

2. Select Analog or Digital.

3. Then click on the Add button. Application will pop up an Add New Channel 
Window.

4. Fill and complete respective fields and drop down boxes for the channel to 
add, like Name, Major No., Minor No., Program Type etc. These fields and 
their name will shown depend on selected region.

5. Click on Add Button to add the channel otherwise click Cancel.

(For DTV channels in ATSC models display number has two fields (major-
minor) which can be set to any vaules from 0 to 999.)

Channel Category All is 
selected as default

This will filter the 
channels in the list 

according to their type 
Air, Cable or Satellite.

Buttons to Add, Edit 
and Delete Channels  

Channel List    

Analog/Digital Radio 
selection will further 

filters channels in the list 
according to their type.
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 y Modify an existing Channel from the list

To modify parameters (like PTC no., Program type, etc) of an existing channel from the list user must follow the following 
steps:

1. Select Air, Cable or Satellite whichever type of channel user wants to edit.

2. Select Analog or Digital.

3. Select the channel from the list to Modify and click on Modify button.

4. Modify the respective fields and drop down boxes for the channel to edit.

5. Click on Edit Button to modify the channel otherwise click Cancel

(For DTV channels in ATSC models display number has two fields (major-minor). 
Channel display number minor part can be changed from SIRCH application but 
not from TV. )

 y Delete a Channel from the list

To delete an existing channel from the list user must follow the following steps:
1. Select Air, Cable or Satellite whichever type of channel user wants to delete.

2. Select Analog or Digital.

3. Select the channel from the list to Delete and click on Delete button.

 y Channel - Editor

To change display no. or channel name user must follow the following steps:

1. Select Air, Cable or Satellite whichever type of channels user 
wants to edit.

2. Select Analog or Digital.

3. Select the channel from the list to Edit and click on Channel-Edit 
button.

4. Change the display no. or Channel name of the channel. Click on 
OK Button to edit the channel.

5. If a new display no. already exits, application will ask user to 
modify the display number. On clicking Yes, application will swap 
the new channel with the existing one. 
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 y Saving Clone Files

To save the clone files with modified parameters and channel map configuration user must follow the following steps:

1. When user has done all the changes in Interactive/Standalone 
menu and in Channel map, click on the Save Button.

2. A browser window will open, which will ask for location to save 
the clone files.

3. Select the folder where clone files should be saved or make a 
new folder and click Ok.

4. After clicking Ok files will be saved with inside a folder named 
with version no. of the model. User can find clone files inside 
(Location given by user) → (Version no, of Model) → Clone.

 y Going Back to Main Screen

1. To go back to main screen click on Back button.

2. This operation will not save all you parameter changes or channel map configuration, so be sure to save clone files 
before going back and select some different model.

 y Merging with TS- Stream

To merge clone file with TS-stream follow following steps:

1. Go to File Menu → Utility → Generate and click on Launch TS-
Merge.

2. Please read about Update version clauses [2.13] before merge.

3. Select Merge Clone files radio button to clone files.

4. Browse Clone files folder.

5. Browse seed stream folder. 

6. Click on generate button to generate stream and output stream 
will be generated. This step will take few minutes to create 
output stream.
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 y Launching Ventus application

Go to File Menu → Utility → Generate and click on  GO for Launch Ventus

 y Upgrading clone or binary file on TV

To upgrade the clone for binary file on TV, keep prepared merged stream (Binary_outputstream.mpg or clone_
outputstream.mpg).

1. Locate stream file in Modulator utility ( as explained in 2.11).

2. Set the set channel to broadcast the stream by clicking on Frequency Table.

3. Select Opencable for ATSC or DVB-C for DVB models.

4. Click Play Button to broadcast the stream.

5. In TV’s factory menu, SIRCH channel must be same as the channel on which stream is broadcasting.

6. And SIRCH version must be smaller than the software version set before generating stream file.

7. Click on Manual SIRCH. (Please check channel setup is set to Cable not Air if cable is connected to TV for 
broadcasting.) 

 y Updating the application with new Model

To update the application with new model, so that you can configure the clone files for that model user must possess a 
model installation XML file. To update new model user must follow following steps:

1. Go to File Menu → Update New Model.

2. A window (Add/Update Model) will open and asks user to enter 
Configuration file (Model installation xml file).

3. To locate model installation xml file click on browse button. A file 
browser window will open where user can locate the file.

4. After selecting the installation file, window will show model name, 
series, region and TV model name in the textboxes which are 
disabled to user.

5. To add model click on Add button. If model already exists 
application will update the model otherwise it will add the model in 
the model dropdown box.

6. To close the window click on Close button.



41English

 y Update SIRCH Version 

To update SIRCH version for Clone and user should follows as below.

1. Go to File Menu → Update Software Version.

2. A window will open which ask for Software Version (Clone File Up gradation).

3. User should provide higher version than TV version in version value. E.g.  

i) If software version is set as 01a0 in SIRCH PC application, then current TV SIRCH version should be less than 
this value for update. 

4. Software version value for clone should in hexadecimal format e.g. fa1b but less than ffff. 

5. After provide value click on Update button for update version value.

 y Closing the application 

1.  To close the application either click the close button on top right corner or go File Menu and Exit.



42 English

 y FAQs 

If SIRCH seems to have a problem, first review this list of possible problems and solutions.

 y Test SIRCH modulator controller settings:

- The SIRCH upgrade only support OpenCable & DVB-C

- Recommended setting

- Parameters Constellation: 64 QAM

- Remux(H/W) : Off

- SIRCH Frequency should be matched SIRCH Channel of TV.

- If you change frequency table, please refer the frequency table in SIRCH manual (Appendix A).

- You should set same channel in both SIRCH PC program and in TV. For ex. if you have empty 2channel (57MHz) in 
Hotel, you should set 2channel(57MHz) both SIRCH PC program and TV.

- Default initial value : SIRCH 87 (603MHz), TV SIRCH Channel : 87
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 y Test version information while merging files into stream : 

- To merge clone files ensure while merging SIRCH clone version in SIRCH PC program should be greater than the 
SIRCH version stored in TV.

- To merge binary file ensure the binary merged into the stream has higher version than the binary already updated in 
TV.

- TV SIRCH version should be less than SIRCH PC application value for update.

- PC application: SIRCH Version (Clone): 0002, TV SIRCH Version: 0001. Update is possible. After update TV version 
will be set equal to SIRCH PC version, hence TV will be 0002.

- PC application: SIRCH 
Version (Clone): 0002, TV SIRCH 
Version: 0002. Update is not possible.

- Merge TV Binary : support to upgrade Main SW.

- You need to contact to Samsung to have Merge TV Binary.

- Merge TV Binary could not support to upgrade Sub Micom
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 y Merged TS Stream should be located in D:\stream\OpenCable(US) or D:\stream\DVBC(EU)

- You can check displaying SIRCH merged stream if you tune SIRCH channel.
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 y Cautions for Hospitality mode options

- Hospitality Mode: should be Standalone. – Interactive mode could not support SIRCH.

- Power On Source must be set TV. If you select others external source, SIRCH cannot support upgrade.

- If you try to upgrade SIRCH in external source (PC/HDMI…), SIRCH could not support upgrade by manual SIRCH / 
SIRCH Update Time.

- SIRCH Upgrade Time: not off.

- Dynamic SI should be set ‘Off’ to modify DTV display channel map in channel map tap. 

 y Which all TV broadcasting standard supported by SIRCH application?
SIRCH application support only ATSC and DVB .

 y  How to add channels for DVB /ATSC?
User need to select particular TV region and model no. On basis of these parameter application allow to add channel 
for DVB(for EU) or ATSC (for US). Please refer section 2.7.

 y  What all broadcasting type SIRCH Modulator supports?
SIRCH modulator support only DVB-C (for DVB)and OpenCable(for ATSC) standard for broadcasting.

 y What is difference b/w Channel in channel map and Channel configured in SIRCH modulator?

 – Channel in Channel Map are used watch channel on TV. We can add more than one channel in channel map. It is in 
form of clone data and transfer using seed stream. On other hand Channel configured in SIRCH modulator is used 
for broadcast data (clone or binary) from modulator with fixed frequency or channel number. This same channel 
number is used on TV named as SIRCH channel for software update. (Please refer Appendix A). 
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 ¦ SW Clock

The SW Clock shows the current time on the screen when the user presses the Info remote control key in standby mode.
 – If a user presses the Info key when the TV is in standby mode, the TV is turned on and shows the current time on the 

screen for 10 seconds and then returns to standby mode.
 – The time is displayed as a digital clock at the normal banner size. The 12 or 24 hour time format of is determined 

according to the format of the Information.
 – If the user presses the Info key when the TV is on, the original Info key function is executed.

 y Detailed Descriptions
 – The SW clock works depending on the On/Off setting in the Factory install menu.
 – If the SW clock is turned on, the Fast logo is automatically turned off. (In this case, even if you turn the Fast logo on 

again, it is automatically turned off when the TV is turned on again.)
 – If the master power is turned off, the time setting is only maintained in models with a backup condenser and an RTC.
 – When a TV in standby mode shows the current time, the video mute and audio mute settings are maintained.
 – In this case, even if the Hotel logo is set to on, the Hotel Logo display is skipped.
 – This feature only works in StandAlone mode.
 – Other key function specifications when the SW clock is running
 – The Info key works like the power key.
 – Pressing the Power or Info key while the SW clock is running, puts the TV into Standby mode.
 – Pressing keys other than the Power and Info keys is ignored while the SW clock is running.
 – In this case, the on timer does not work.
 – The off timer and sleep timer work.
 – When clock mode in the Time menu is set to manual, the time of the sub micom is maintained by the RTC circuit.
 – Even if the current time is not configured, it is displayed in the same way as the menu. (--:--)
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 ¦ Multi Code Remocon

Multi Code Remocon is a special transmitter which is designed to control each TVs with one remote.
This function is useful where there is more than one TV in one location like hospital Set ID number will be displayed in source 
osd. It is possible to support up to 9 different remote key transmission for multi code.
Initial ID code which each TV has is “0”.

 – ID code could be set and reset in Analog TV mode or PC mode. (not available in TTX channel or DTV channel)
 – ID code could be from 0 to 9.
 – Press Blue Key for over 7 seconds and the digit key a user wants to set.
 – Set ID OSD will be displayed in central position.
 – The following words will be displayed. “Remote control code is set to x. If you want to change Remote control code. 

Enter the digit you want to change.” (x is the digit number) This OSD will be kept displaying until exit key is input. 

Remote control code is set to 0. If you want to 
change Remote control code, enter the digit you 
want to change.

 – For example, TV and Remote will be set ID code #1 if user presses #1.
 – The following words will be displayed.“Remote control code is changed to 1” Then TV can be controlled by only remote 

which has same ID code with TV’s.
 – If ID code does not match between remote and TV, the following words will be displayed. “ TV ID x”(x is the TV’s ID)
 – To reset ID code, press Yellow key for over 3 seconds. ID code of both TV and Remote will be reset to “0”. “Remote 

control code is set to 0.” will be displayed.

 ¦ Setting the Time

 O MENU → System → Time → Clock → Clock Set

 y The time is entered
 – Press the remote control button to select Clock set and set up the time.

 y Setting the Interactive Mode Time
 – If the Hotel System transmits time information, the time is set automatically.
 – If the Hotel System does not transmit time information, the time cannot be 

displayed. 

 ✎ If the time is set, clock will be displayed on the front panel.

Time

Clock

Sleep Timer   Off

Wake-up Timer

Clock

Clock Mode  Manual

● Clock Set

● Time Zone  Auto
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 ¦ Channel Bank Editor (Smoovie TV Only)

Channel Bank Editor is a function to edit the channel with 3 different Bank Options.
Depending on the Bank card, there are specific channels Hotel customer can enjoy.

Setting the Channel Bank Editor under Stand-alone Mode

1. Enter the Hotel Standalone menu by “MUTE+1+1+9+Enter”

2. Please select SI vendor : “Smoovie”

3. You will be able to find new menu option “Channel Bank Editor”

4. Enter the “Channel Bank Editor”

Hospitality Mode Standalone SIRCH

SI Vendor OFF Service

d

SI Vendor Smoovie

d

Channel

d

Channel Bank Editor

<Depending on model and region, some menu items may not exist>

5. Edit the channel bank like below example.

a. Bank1 (Free channel): Select the channel that will be used when remote doesn’t have any card.

b. Bank2 (Family Card - Green): Select the channel that will be used when remote has the GREEN CARD.

c. Bank3 (Adult Card - Red): Select the channel that will be used when remote has the RED CARD.

Channel Bank Editor 

 Move      Select/Deselect      Return

       All

1   1futech

1    BBC 1

2    24ore.tv

2    C3

3    BBC World

3    C5

4    Coming Soon

4    S2

Bank1 (4) Bank2 (6) Bank3 (36)

References of using SMOOVIE Remote Controller

 1. If you select SMOOVIE as SI vendor, you should use SMOOVIE Remote Controller.

 2. With Numeric key of remote controller, user can select only Bank1 channel. 
In this reason, if you want to change the channel using Green or Red Card, please use channel up/down keys. 

 3. At the Channel guide or the Channel list, user can see only Bank1 channel list.
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 ¦ Channel Editor

Channel Editor is a function to edit channel number and name.
 – Use Channel Editor to sort the channels as user-desired channel numbers.

Hospitality Mode Standalone SIRCH

SI Vendor OFF Service

Power On

Channel

My Channel

Menu OSD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cloning

r Channel Editor

<Depending on model and region, some menu items may not exist>

Simple Steps for channel Editor under Stand-alone Mode

Step Broad Outline

1 Operate ‘Channel Auto Store’ in Hotel Option Menu
2 Enter ‘Channel Editor’ in Hotel Option Menu
3 Compile a table related to the final channel lists you want to have
4 Rearrange channels with TOOLS Button based on the table you compiled 
5 Press EXIT or RETURN Button to exit.

<For better comprehension, please refer to the following details>

 Smoovie On sequence 

Step

Smovie TV used (Air/ Cable )

Mixed Channel Map On (Air and Cable both used) Only Air or Cable used Only Air or Cable used

If the tv starts with Hotel P&P If P&P alredy done If the tv starts with Hotel P&P If P&P alredy done

1 Do the P&P except channel store Enter Hotel menu Do the P&P all (Air or Cable 
auto tune) Enter Hotel menu

2 After P&P TV will show hotel 
menu Setup Mixed Channel Map On After P&P TV will show hotel 

menu

Select channel type
- ATV or ADTV for Air
- CATV or CDTV for cable

3 Setup Mixed Channel Map On Make TV power off & on
Select channel type
- ATV or ADTV for Air
- CATV or CDTV for cable

Select smoovie TV in Hotel menu

4 Make TV power off & on Enter Hotel menu Select smoovie TV in Hotel menu Select Channel Setup

5 Enter Hotel menu Select smoovie TV in Hotel menu
Select Channel Setup
(can be skipped)

Select "Air" or "Cable" to auto 
tune

6 Select smoovie TV in Hotel 
menu Select Channel Setup Select "Air" or "Cable" to auto 

tune (can be skipped) setup CH Bank Editor

7 Select Channel Setup Select "Air + Cable" to auto tune Setup CH Bank Editor After power off & on, user can 
use TV

8 Select "Air + Cable" to auto 
tune Setup CH Bank Editor After power off & on, user can 

use TV

9 Setup CH Bank Editor After power off & on, user can 
use TV

10 After power off & on, user can 
use TV
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Step

Smovie TV used( Satellite )

Mixed Channel Map On (Satellite and Air or Cable both 
usedused) Only Satellite used

If the tv starts with Hotel 
P&P If P&P alredy done If the tv starts with Hotel 

P&P If P&P alredy done

1 Do the P&P except channel 
store Enter Hotel menu Do the P&P all ( Air or Cable 

auto tune) Enter Hotel menu

2 After P&P TV will show hotel 
menu

Setup Mixed Channel Map 
On

after P&P TV will show hotel 
menu

Select channel type
- ATV or ADTV for Air
- CATV or CDTV for cable

3 Setup Mixed Channel Map 
On Make TV power off & on

Select channel type 
- ATV or ADTV for Air 
- CATV or CDTV for cable

Select smoovie TV in Hotel 
menu

4 Make TV power off & on Enter Hotel menu Select smoovie TV in Hotel 
menu Select Channel Setup

5 Enter Hotel menu Select smoovie TV in Hotel 
menu

Select Channel Setup (can 
be skipped) Select Satellite to auto tune

6 Select smoovie TV in Hotel 
menu Select Channel Setup Select Satellite to auto tune 

(can be skipped) Setup CH Bank Editor

7 Select Channel Setup Select Satellite to auto tune Setup CH Bank Editor After power off & on, user 
can use TV

8 Select Satellite to auto tune Setup CH Bank Editor After power off & on, user 
can use TV

9 Setup CH Bank Editor After power off & on, user 
can use TV

10 After power off & on, user 
can use TV

Channel List

You can view channel information, All, TV, Radio, Data/Other, Analogue or Favourites 1-5. 
 ✎ When you press the CH LIST button on the remote control, Channel List screen will be displayed at once.

Channel List Guide AllShare Play Schedule Manager Source

Contents Home

R Return

*  The displayed image may differ depending on the model.

 y All: Shows all currently available channels.
 y TV: Shows all currently available TV channels.
 y Radio: Shows all currently radio channels.
 y Data/Other: Shows all currently available MHP or other channels.
 y Analogue: Shows all currently available analogue channels.
 y Favourites 1-5: Shows all favourite channels.

 ✎ If you want to view favourite channels you added, press the CH LIST button and use L (Ch. Mode) button to 
move Favourites 1-5.

 ✎ Using the control buttons with the Channel List.

 x T (Tools): Displays the option menu.

 x L (Ch. Mode / Channel): Move to the All, TV, Radio, Data/Other, Analogue or Favourites 1-5.

 ✎ When you select the Programme View in T (Tools) menu, you can move to other channels using L 
(Channel) button.

 x E (Watch / Information): Watches the channel you selected. / Displays details of the selected programme.

 x k (Page): Move to next or previous page.
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How to use Schedule Viewing in Channel List

(digital channels only)
When you set the Schedule Viewing in Channel List, you can only set the programme in Programme View.
1.  Press the CH LIST button, then select a desired digital channel.

2.  Press TOOLS button, and then select the Programme View. The programme list for that channel appears.

3.  Press the ▲ / ▼ buttons to select the desired programme, then press the ENTERE (Information) or INFO button.

4.  Select Schedule Viewing, then press the ENTERE button when done.

 ✎ If you want to cancel Schedule Viewing, follow steps 1 through 3. Select Cancel schedule.

Using Option Menu t
Set each channel using the Channel List menu options (Programme View, Edit Favourites, Lock/Unlock, Edit Channel 
Name, Edit Channel Number, Delete, Information, Sort, Edit Mode).
Option menu items may differ depending on the channel status.
1. Select a channel and press the TOOLS button.

2. Select a function and change its settings.

 y Programme View: Displays the programme when digital channel is selected.
 y Edit Favourites: Set channels you watch frequently as favourites. Add or delete the selected channel in Favourites 1-5.

1.  Select the Edit Favourites, then press the ENTERE button.

2.  Press the ENTERE button to select Favourites 1-5, then press the OK button.

 ✎ One favourite channel can be added in several of favourites among Favourites 1-5.

 y Lock/Unlock: Lock a channel so that the channel cannot be selected and viewed.
 ✎ This function is available only when the Channel Lock is set to On.

 ✎ The PIN input screen appears. Enter your 4-digit PIN. Change the PIN using the Change PIN option.

 y Edit Channel Name (analogue channels only): Assign your own channel name.
 y Edit Channel Number (digital channels only): Edit the number by pressing the number buttons desired.

 ✎ Some area may not be able to support Edit Channel Name and Edit Channel Number function.

 y Delete: You can delete a channel to display the channels you want.
 y Information: Displays details of the selected programme.
 y Sort: Changes the list ordered by channel number or channel name.
 y Edit Mode: You can select desired channels and edit it.

Using Option Menu t
Set each channel using the menu options (Edit Favourites, Lock/Unlock, Delete, Deselect, Select All).
1.  Press the TOOLS button in Channel List screen, then select the Edit Mode. A check box appears to the left of the 

channel.

2.  Press the ▲/▼ buttons to select the desired channel, then press the ENTERE button. The (c) mark indicates the 
channel you’ve selected.

 ✎ You can select more than one channel.

 ✎ Press the ENTERE again to deselect the channel.

3.  Press the TOOLS button, then select a function and change its settings.

 y Edit Favourites: Set the selected channels you watch frequently as favourites.
 ✎ The Edit Favourites screen has five groups (Favourites 1, Favourites 2, etc.). You can add a favourite channel to 

any one of the groups. Press the ▲/▼ buttons to select a group.

 y Lock/Unlock: Lock a channel so that the channel cannot be selected and viewed.
 ✎ This function is available only when the Channel Lock is set to On.

 ✎ The PIN input screen appears. Enter your 4-digit PIN. Change the PIN using the Change PIN option.

 y Delete: You can delete a channel to display the channels you want.
 y Deselect: Deselect the selected channels.
 y Select All: Select all the channels in the channel list.
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 ¦ My Channel

Determines the country and genre for the channels provided by the hotel, and if the user selects a country and genre, shows 
the corresponding channels.

 y You must select the country first, or you can NOT set a genre.
 y If you select the genre that NOT added any channels, Channel list display all of channels.
 y My Channel works in Standalone mode only.
 y SI Vendor in Standalone mode: This des not work if Smoovie is selected.
 y This is in the Hotel Options in Hotel Menu > Service Mode and can be turned on or off.
 y The option only works when it is set to On.

Channel Composition [Genre Mode]

Standard Category Ch. Mode
Antenna Mode Activation

Description
Air/Cable Satellite

Hotel Genre

All (Default) O O

Provide genre channel mode by each 
country that master has managed in 
factory mode.

News O O
Radio O O
Entertainment O O
Sport O O
Hotel O O

My Channel

Current status : Austria/Sports

Country Genre

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

(Blue)Keep Previous (U/D/L/R)Move (En)Enter

* For the number of items to be displayed in the list, refer to the design document.

Key Guide

Button Action Nav. Help

BLUE Returns to the screen. (Genre setup: Last Country & Genre) Keep Previous

ENTER Selects an item. Enter

< CH > Move the highlight by page. (No Guide)

▲/▼ Navigates the each country, genre list. (in a circular manner.)
Move

► Selects the highlighted item, and then move the highlight to Genre section.

RETURN Returns to the screen. (Genre setup: Last Country & Genre) (No Guide)

EXIT Returns to the screen. (Genre setup: Last Country & Genre) (No Guide)

1

8

3

6

7

2

4 5
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 ✎ Notes

 x This section describes the layout of Front UI that appears when TV is turned on. (Factory Mode > Genre Mode: 
Enable)

 x The genre is sub-list of each country.

 x The broadcast screen that was being displayed the last memorial channel.
 – If user want to keep previous country & genre channel map, presses ‘BLUE’, RETURN, EXIT remote-control key to 

close the Front UI.

 ✎ Etc.

 x Default Highlight : Last Memory items (Country, Genre)

 x Timeout (60 sec)
Elements

No Name Description

1 Background Screen  y Displays the last memorial channel that shows when TV is turned on.

2 Function Title  y This is name of the function.

3 Current Status  y Display current settings the Country/Genre.

4 Country Items
 y The item for the country list is displayed.
 y Displays the last selected country.

5 Genre Items

 y The item for the genre list is displayed.
 y Displays available genre items by each country that master managed in factory 

mode. (always provide ‘All’ item)
 y Displays the last selected genre.

6 Highlight  y If the item title is too long to be displayed within the area, Auto Text Sliding works.

7 Indicator  y This is displayed when there is a previous or next page.

8 Nav. Help  y The key guide is right-aligned.
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Highlight Interaction [Country Items]
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

 ✎ Notes

 x User can navigate the list items in each country & genre list by pressing the up or down remote control keys.

 x Circular navigation is supported.

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Austria All

Belgium (Dutch) News

Belgium (French) Radio

Czech Entertainment

France Sports

Germany Hotel

Hungary

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Slovakia All

Spain News

Switzerland Radio

United Kingdom Entertainment

Eastern Europe Sports

Other Hotel

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Slovakia All

Spain News

Switzerland Radio

United Kingdom Entertainment

Eastern Europe Sports

Other Hotel

▼

DOWN x 4

DOWN x 4

DOWN x N

DOWNDOWN

UP x 4

UP x 4

UP x N

UPUP

END

1
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Highlight Interaction [Default Genre]
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

 y The current selection of the country is high-lighted.  y Default High-light: The current selection of the genre.

 y Tthexet other item of the county is high-lighted. (ex. France)  y Default Highlight : All

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

ENTER / RIGHT

ENTER / RIGHT

LEFT

LEFT

My Channel

Current status : All Country/Sports

Country Genre

▲

Austria All

Belgium (Dutch) News

Belgium (French) Hotel

Czech

France

Germany

Hungary

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

Austria All

Belgium (Dutch) News

Belgium (French) Hotel

Czech

France

Germany

Hungary

▼

Navigation Help Area
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Mode Change Interaction 1 (1/2)
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

1

 y Current Genre Mode : All Country / Sports

 y If the country is selected, highlight move to genre menu 
automatically.

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Hotel

Czech

France

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Hotel

Czech

France

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Hotel

Czech

France

Germany

▼

Navigation Help Area

DOWN

LEFT

DOWN

UP

ENTER / RIGHT

ENTER / RIGHT

ENTER

6



57English

Mode Change Interaction 1 (2/2)
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

5 6

 y The genre mode change complete message is displayed.
 y Timeout(5 sec.)

 y If the left key is pressed from the genre to country menu, 
highlights an existing selected country item.

Current Status : Austria / News

ENTER / RETURN / Timeout

ENTER

1

Info
Genre Mode change to Austria/News.

OK

1

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Hotel

Czech

France

Germany

▼

Navigation Help Area
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Mode Change Interaction 2 (1/2)
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

1

 y Current Genre Mode : All Country / Sports

 y If the country is selected, highlight move to genre menu automatically.

 y Current Genre Mode : All Country / Sports

Current Status : Austria / News

ENTER / RIGHT

DOWN

UP x 5

BLUE

/

RETURN

/

EXIT

ENTER

/

RETURN

/

Timeout

101

Info
Genre Mode change to Austria/News.

OK

5

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Sports

Czech Hotel

France

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Sports

Czech Hotel

France

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Sports

Czech Hotel

France

Germany

▼

Navigation Help Area
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Power On Scenario [Last Memory]
•	This	page	is	only	for	interaction.	Each	screen	may	not	be	exactly	identical	to	actual	one.

1

 y Current Genre Mode : Austria / News

 y Current Genre Mode : Austria / News

Current Status : Austria / News Power Off
POWER

POWER

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Entertainment

Belgium (French) Hotel

Czech

France

Germany

▼

Navigation Help Area
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Genre Editor (This configures the genres of each of the hotel TV channels.)
 y This can be used through the Hotel Menu (Factory).
 y Supported genres include News, Radio, Entertainment, Sports and Hotel.
 y More than one genre can be selected for each channel at the same time.

Country Editor (Channel Editor): This is the editor that configures the country for each of the hotel TV channels.
 y Supported countries (20 countries): Austria, Belgium, China, Denmark, Finland, France, Germany, Greece, Italy, Japan, 

Netherlands, Norway, Portugal, Russia, Korea, Spain, Sweden, Turkey, USA 
 y If more than one channel is set to a country, the country is registered as a category and users can view the channels by 

country.
 y  More than one country can be set to a channel. If the user selects a category, only the channels corresponding to the 

country are displayed in the channel list.
 y If any channel for which the country is set is selected from the channel list, the Edit Countries item is added to the Tools. 

Otherwise, the Add to Countries item is added to the Tools.
 y * If the corresponding function is executed, a country for the selected channel can be set or canceled.
 y Front UI
 y Provides the screen where the user can select a country or genre when the user turns the power on.

Left Frame Layout

Key Guide

Button Action Nav. Help

ENTER Selects or enters the corresponding Channel Browser area. (No Guide)

RETURN Selects or enters the corresponding Channel Browser area. Return

▲/▼ Moves the highlight up or down. (No Guide)

► Moves the highlight to the Channel Browser area. (No Guide)

INFO Shows the Category Info. (No Guide)

TOOLS Shows the utility function menus. Tools

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes

 x  This is a component of the Left Frame (Country Categories).

 ✎ Etc.

 x Default Highlight: ‘The currently selected country’
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Elements

No Name Description

1

 y  When the user enters this screen, the currently selected default item is highlighted.
 y  The Country Icon + Category Name are provided. (If the highlight is in the Main 

Frame, only the icon is displayed.)
 y  Moving the highlight

 – Pressing the up or down button moves the highlight.
 – If the items cannot be displayed on one page, up and down indicators are 

provided.
 – Once the highlight is moved to a category, the channel list corresponding to the 

corresponding category is loaded to the Main Frame.

Left Frame [Country Categories]

Standard Category Ch. Mode
Antenna Mode Activation

Description
Air/Cable Satellite

Hotel

Original Tuned Registered O O
 y Lists all the channels registered by the Auto 

Tune operation.

Country All Country O O
 y Provides the list of channels and sources 

specified in the Registered Channels list.
 y All Country is the sum of all channels 

registered to each country. (This is only 
provided to end users.)

Country 1 O O

Country 2 O O

. O O

Tools [Registered/Countries Categories]

•	Channel	Manager	>	Channel	Category	>	Tools	>	Info

 y The items are displayed without ‘Channel’.

 y If the Registered/Country item in the Left Frame is highlighted, 
you can enable the corresponding window by pressing the 
‘INFO’ remote control key.

 y All countries are displayed.

 y You can navigate country items by pressing the up or down key. 
(Indicators are provided.)



62 English

 ✎ Notes

 x This is a definition of the Tools menu in the Left Frame Category.

 x Only the Info item for each Register/Country is provided.

Elements

Category Tools menu Descriptions

Registered, Country Information Registered Channels. The number of channels of each country.

•	The	items	are	displayed	without	‘Channel’.

Error Cases

 ✎ Notes

 x This is the message for when there are no saved channels in the Registered Channels list.
Elements

No Name Description

1 Message

 y When entering the browser, if the Registered channels item is empty, a popup message is 
displayed which enables users to switch to the Auto Store (Program) menu.

 y When both the time and the channel are not configured, and a user enters the Channel 
Manager, a message that allows the user to switch to the Auto Tuning (Auto Program) 
operation is displayed in the same way as above.

 x This is the message when the time is not configured.
 –  If the time is not configured, the message is displayed in Factory Mode before entering the Channel Manager.
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 ✎ Notes

 x This is the component for when there are no channels registered to the country category.

Elements

No Description Description

 y The message is displayed when the currently selected country does not contain any 
items.

Main Frame [Channel Browser]
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Key Guide

Button Action Nav. Help

< CH > Moves the page. Page

ENTER Selects or enters the corresponding Channel Browser area. Select

RETURN Returns to the previous step (Factory Mode). Return

▲/▼ Moves the highlight up or down. (No Guide)

► Moves the highlight to the Channel Browser area. (No Guide)

INFO Shows the Category Info. (No Guide)

TOOLS Shows the utility function menus. Tools

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes

 x This is a component of the Main Frame (Channel Browser).

 x The initial highlight is on the channel before entering Factory Mode or the external input.

Elements

No Name Description

1 Main Frame  y Shows the channel or the source list of the currently selected category.

2 Scroll Bar  y Shows the position of the current page amongst the total amount of pages.

3 Navigation Help Area
 y This is displayed whenever a user enters the Channel Manager. (If a user exits and then 

reenters the Channel Manager, it is displayed again.)
 y This disappears when the timeout (5 sec.) is reached or a user presses a key.

4 Navigation Help Area
 y The currently configured country information and the RED buttons are left-aligned. 

(They are displayed and navigated by group graphically.) The key guide is right-aligned.
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Channel Common Elements [+ Icon-method]
Channel list representation rules

Standard Item Construction

ATSC

Digital channels
•	Check	Box	+	Status	Icon	+	Digital	Channel	Number	+	Channel	Name

 – Channel number representation format: ###-### (The channel number is 
represented by ‘-’.)

Analog channels
•	Check	Box	+	Analog	Icon	+	Analog	Channel	Number	+	Channel	Name

 – Channel number representation format: ### (‘-’ is not used to represent 
analog channel numbers.)

DVB (CHEM)

Digital channels
•	Check	Box	+	Status	Icon	+	Digital	Channel	Number	+	Channel	Name

 – Channel number representation format: ### (For the maximum length of the 
channel number representation, follow the regional specifications.)

Analog channels
•	Check	Box	+	Analog	Icon	+	Analog	Channel	Number	+	Channel	Name

 – Channel number representation format: ### (For the maximum length of the 
channel number representation, follow the regional specifications.)

Channel list icon representation rules

Item Example Priority

Dynamic SI
Icon

Channels deleted 
by Dynamic SI  NNNNNNNN CH. NAME

 y Channels that have been deleted by the 
Dynamic SI but not by the user.

1

Channels added 
by Dynamic SI  NNNNNNNN CH. NAME

 y Channels that have been added by the 
Dynamic SI but not by the user.

2

Analog Channel Icon
 NNNNNNNN CH. NAME (The 

edited channel name.)
 y The analog channel icon is displayed. 3

Source Channel Icon
 NNNNNNNN CH. NAME  y A channel that is an input source. 4

Antenna Icon Air
 NNNNNNNN CH. NAME

 y Represents the live channels from the 
antennas. The Air, Cable or Satellite 
antenna icons are displayed at the lowest 
priority.

5Cable
 NNNNNNNN CH. NAME

Satellite
 NNNNNNNN CH. NAME

Scrambled Channel Icon NNNNNNNN CH. NAME 
 y The scrambled channel icon. (This 

appears for the Satellite antenna.)
-

Video Mute NNNNNNNN CH. NAME 
 y A screen-muted channel. (Audio and 

channel information is provided.)
-
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Add to Countries / Edit Countries (1/2)

Key Guide

Button Action Nav. Help

ENTER Selects the highlighted item. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

▲/▼ Moves the highlight over country items. Move

◄/► Moves the highlight. Move

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Note.

 x This is the definition of Add to Countries. 

 x The highlighted channel or more than one selected channel is added to the Country category.

 ✎ Etc.

 x Timeout (60 sec)

•	Channel	Manager	>	Browser	>	Tools	>	Add	to	Countries
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Elements

No Name Description

1
Add to Countries
Window

•	If	there	are	no	channels	that	have	been	registered	to	the	country	list	in	the	selected	
channels, “Add to Countries” is displayed as the title.
•	A	check	box	is	displayed	depending	on	whether	the	country	that	was	selected	when	
entering the screen is registered or not.

2 Guide

3 Selection Info

•	The	number	of	the	selected	channel	or	the	channel	name.
- The channel name is displayed when one channel has been selected: Selected channel: 
NNNN-NNN ABC
- The number of selected channels is displayed when more than one channel has been 
selected: Selected Channels : N

4 Complete Message
•	The	message	is	displayed	after	the	completion	of	the	operation.	(This	message	is	always	
displayed if the OK button is selected.)

5 Selection Mark

•	How	to	identify	the	meaning	of	multiple	channel	selection	marks
	•	When	all	of	the	items	have	been	registered.
	•	When	only	part	of	the	items	have	been	registered.
	•	When	none	of	the	items	have	been	registered.

Add to Countries / Edit Countries (2/2)

Key Guide

Button Action Nav. Help

ENTER Selects the highlighted item. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

▲/▼ Moves the highlight over country items. Move

◄/► Moves the highlight. Move

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

•	Channel	Manager	>	Browser	>	Tools	>	Add	to	Countries
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 ✎ Notes

 x This is the definition for Edit Countries. 

 x The highlighted channel item or more than one selected channel item is added or deleted from the Country category.

 ✎ Etc.

 x Timeout (60 sec)

Elements

No Name Description

1 Add to Countries

 y If there is a registered channel among the selected channels, Edit Countries is 
displayed as the title.

 y A check box is displayed depending on whether the selected country is registered 
or not.

2 Guide

3 Complete Message
 y The message is displayed after the completion of the operation. (This message is 

always displayed if the OK button is selected.)

Edit Channel Number [Swap Type]

•	Channel	Manager	>	Browser	>	Tools	>	Edit	Channel	Number

Key Guide

Button Action Nav. Help

ENTER Applies the changes and closes the window. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

▲/▼ Changes the channel number of the selected channel. Adjust

0~9 Enters a digit. Number

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes

 x This is the definition of the function that changes the channel number. (Swap Type)

 x Channel numbers can be changed in all the channel lists and changes are applied to all the channels.

 x If the new channel number has not been allocated to another channel, the channel number is updated to the new 
channel number and the list is sorted again in ascending order of channel number.

 x If the new channel number has already been allocated to another channel, follow the Hotel specifications.
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 ✎ Etc.

 x Vertical circulation is supported.

Elements

No Name Description

1
Edit Channel
Number Window

 y Both the numeric keys and the Up/Down keys are supported.
 – Selected Channel: Shows the currently selected channel name.
 – Number: Shows the new channel number.  

(The currently allocated channel name is also displayed.)
 – Name: Shows the currently allocated channel name. (If there are no channels, it is 

displayed as “(Empty)”.) : If there is a channel but it does not have a name, the name 
is represented as “-----”.

2
Warning
Message

 y If an already allocated channel is selected
 – If the new channel number has already been allocated to another channel, the 

confirmation message pops up. (Refer to the figure below.)
 – If the user wants to change the channel number to one that has already been 

allocated to another channel, the channel numbers are swapped and saved.

Edit the Channel Number [External Input] (3/3)

•	Channel	Manager	>	Browser	>	Tools	>	Edit	Channel	Number
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Key Guide

Button Action Nav. Help

RED If a user presses the button, the channel number is initialized. Reset

ENTER Applies the changes and closes the window. Enter

RETURN Cancels or returns to the previous screen (Tools). Return

▲/▼ Changes the channel number of the selected channel. Adjust

0~9 Enters a digit. Number

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes

 x This function allocates an external input source to a channel number. (The changes are applied to all the channels.)

 x If the new channel number has already been allocated to another channel, follow the Hotel specifications.

 ✎ Etc.

 x Default Highlight: Channel number area.

 x Vertical circulation is supported.

 x Timeout (60 sec)

Elements

No Name Description

1 Channel Number Area

 y The channel number area.
 – Both the numeric keys and the Up/Down keys are supported.
 – If no value is allocated, as many ‘-’ are displayed as the number of digits.

▲ ▲ ▲

-- → 1 → 15

▼ ▼ ▼

2 Source Name
 y External input name

 – Items that cannot be configured are disabled.

3 Nav. Help Area  y If a user presses the red button, the channel number is initialized.
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Edit Channel Name

•	Channel	Manager	>	Browser	>	Tools	>	Edit	Channel	Name

Key Guide

Button Action Nav. Help

GREEN Saves the changes and returns to the Channel Manager. Done

ENTER Saves the channel name and moves the cursor to the next field. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

▲/▼/◄/► Navigates on the keyboard. Move

0~9 Enters a digit. (No Guide)

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes

 x This is the definition of the keypad that is used for the Edit Channel Name function.

 ✎ Etc.

 x Timeout (60 sec)

Elements

No Name Description

1 Channel Name Edit Window

2 Channel Name

 y The cursor and the character that are currently being entered are in the color 
of the highlight.

 y When the maximum number of characters is reached, the cursor is not 
displayed.

3 Keyboard  y For a detailed scenario, refer to the keypad design document.
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Tools [Edit Mode]

Edit Mode

Content Highlight (when the number of the checked item is 0 or 1) When there is more than one checked item.

Add to Countries
Edit Countries (when an already-registered item is checked.)
Channel Name Edit
Edit Channel Number
Video Mute
Channel Copy (Astra HD +)
Reorder (Satellite)
Select All
Deselect All (this is only displayed when 1 or more items are 
selected)
Delete

Add to Countries
Edit Countries (when an already-registered item is 
checked.)
Video Mute
Reorder (Satellite)
Select All
Deselect All
Delete

 ✎ Notes

 x This is the definition of the Tools menu.

 x The position of the popup menu: The Tools menu for an item in the left column of the Channel List → This is displayed 
on the right. The Tools menu for an item in the right column of the Channel List → This is displayed on the left.

 x If a user presses the Tools button when the highlighted item is not selected, the item is automatically marked as 
selected.

 x For the detailed specifications of each function, refer to the NEO Channel Manager.
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CH Banner [when a channel number is allocated to an external input]

 ✎ Notes

 x The TV channel banner specifications are applied.

 x When there is an unsupported item or there is no corresponding information, the item values are not displayed.

 x The channel name is represented as the ‘external input name’.

Elements

No Name Description

1 External Input Name

The Channel List provides some functions of the GenreTV.
 y Country Mode
 y Changes the genre mode.

 ¦ Mixed Channel Map

Mixed Channel Map is a function to mix Air, Cable and Setellite channels.
[ Except for Aus, Singapore, NZ models ]

 – Mixed channel Map should be ON in order to mix Air, Cable and Setellite channels.
 – Use Channel Editor to sort the channels after turning on  'Mixed channel Map' in Hotel Option Menu.

 ¦ Sound Bar

 y Samsung Sound-Bar & Hospitality TV in 2012
 – Samsung Sound-Bar & hospitality TV support HDMI 1.4, so you can listen to TV’s sound on Sound-Bar by using single 

HDMI cable.
 – Supporting model.

 y Sound-Bar : HW-E350/E450/E550

 y The operation of “Hotel mode” in Sound Bar
 – The following items of TV’s hotel option menus should be set in advance.

 y Hotel option → Power On → Power ON Volume = "Enable" / Power ON Vol / Max Vol
 y Hotel option → External Device → Sound Bar Out = "On"
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 – Connect an HDMI cable from the HDMI OUT port of Sound-BAR to the HDMI2 port of hospitality TV.
 – After being connected to the 2012 hospitality TV via HDMI Cable, while TV turns on, Sound-Bar automatically detects 

TV and then, will be converted to “hotel mode” by itself.
 – The change with power-on volume & max volume on TV is applied to the connected sound-bar since TV boots twice.

 y Features of "Hotel MODE" in Sound-BAR
 – Synchronized power on/off with TV.
 – HDMI_CEC enabled.
 – Accessible “HDMI OUT” port only. (Other inputs are disabled)
 – Synchronized “power-on”&“max” volume with TV’s one. (Sound-Bar’s volume is set as the half of TV’s one)
 – Adjustable “power-on”&“max” volume acquired from TV’s hotel option menu. (Sound-Bar volume=TV volume/2)

Ex.) If the volume settings in TV are “power-on volume=20 and max volume=90”, Sound bar will work as power-on 
volume=10, max volume=45.

*This function may differ depending on the model.

Installing the Wall Mount

The wall mount kit (sold separately) allows you to mount the TV on the wall. For detailed information on installing the wall mount, see the 
instructions provided with the wall mount. Contact a technician for assistance when installing the wall mount bracket. We do not advice you to 
do it yourself.

Samsung Electronics is not responsible for any damage to the product or injury to yourself or others if you select to install the TV on your own.

Wall Mount Kit Specifications (VESA)

 ✎ Wall mount kit is not supplied but sold separately.
Install your wall mount on a solid wall perpendicular to the floor. When attaching to other building materials, please contact your nearest dealer. If 
installed on a ceiling or slanted wall, it may fall and result in severe personal injury.

 ✎ NOTE

 x Standard dimensions for wall mount kits are shown in the table below.
 x When purchasing our wall mount kit, a detailed installation manual and all parts necessary for assembly are provided.
 x Do not use screws that do not comply with the VESA standard screw specifications.
 x Do not use screws longer than the standard dimension, as they may cause damage to the inside of the TV set.
 x For wall mounts that do not comply with the VESA standard screw specifications, the length of the screws may differ 

depending on their specifications.
 x Do not fasten the screws too strongly, this may damage the product or cause the product to fall, leading to personal injury. 

Samsung is not liable for these kinds of accidents.
 x Samsung is not liable for product damage or personal injury when a non-VESA or non-specified wall mount is used or the 

consumer fails to follow the product installation instructions.
 x Do not exceed 15 degrees tilt when mounting this TV.

inches VESA Spec. (A * B) Standard Screw Quantity

19~22 75 X 75
M4

4
26 100 X 100

32~40 200 X 200 M6

46~60 400 X 400 M8

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal injury 
due to electric shock.
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing onto the TV may cause the TV to fall. In particular, ensure that your children do not hang over or 
destabilize the TV; doing so may cause the TV to tip over, resulting in serious injuries or death. Follow all safety precautions provided on 
the included Safety Flyer. For added stability, install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling 

1. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the screws have been firmly installed onto 
the wall. 

 ✎ You may need additional material such as an anchor depending on the type of wall.

 ✎ Since the necessary clamps, screws, and string are not supplied, please purchase these additionally.

2. Remove the screws from the centre back of the TV, put the screws into the clamps, and then fasten the screws onto the TV 
again.

 ✎ Screws may not be supplied with the product. In this case, please purchase the screws of the following specifications.

3. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong string and then tie the string tightly.

 ✎ NOTE
•	 Install the TV near to the wall so that it does not fall backwards.
•	 It is safe to connect the string so that the clamps fixed on the wall are equal to or lower than the clamps fixed on the TV.
•	 Untie the string before moving the TV.

4. Verify all connections are properly secured. Periodically check connections for any sign of fatigue for failure. If you have any 
doubt about the security of your connections, contact a professional installer.

Anti-theft Kensington Lock

The Kensington Lock is not supplied by Samsung. It is a device used to physically 
fix the system when using it in a public place. The appearance and locking method 
may differ from the illustration depending on the manufacturer. Refer to the manual 
provided with the Kensington Lock for additional information on proper use.
To lock the product, follow these steps:

 ✎ Please find a “K” icon on the rear of the TV. A kensington slot is beside the 
“K” icon.

1. Wrap the Kensington lock cable around a large, stationary object such as desk or 
chair.

2. Slide the end of the cable with the lock attached through the looped end of the 
Kensington lock cable.

3. Insert the locking device into the Kensington slot on the product (1).

4. Lock the lock.

1

<Optional>

 ✎ These are general instructions. For exact instructions, see the User manual supplied with the locking device.

 ✎ The locking device has to be purchased separately.

 ✎ The location of the Kensington Lock may be different depending on its model.
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Specifications

Items Specification Comment

TV System PAL, SECAM, DVB-TC

Audio out

Speaker out 32inch / 40inch / 46inch : 10W x 2

Variable Audio 4W mono 8 ohm SPK'
Phone Jack output
BTL Sound output

Audio out 500mVrms Phone Jack, Monitor out

Input

Component Y, Pb, Pr, Audio-L/R

PC D-sub, Audio-L/R

A/V Audio Video Jack

EXT Scart Jack

HDMI Compatible with the HDMI Specifications

Antenna 75 ohm Unbalanced, Din Jack , F Jack VHF/UHF/CATV

Data
DATA RJ-12

RJP RS232 Jack Pack Only, TeleAdapt RJP Only

Operating temperature 10°C ~ 40°C (50°F  ~ 104°F)

Operating Humidity 10% ~ 80% non-condensing

Storage Temperature -20°C ~ 45°C (-4°F  ~ 113°F)

Storage Humidity 5% ~ 95% non-condensing

 ✎ Design and specifications are subject to change without prior notice.

 ✎ For information about power supply, and more about power consumption, refer to the label attached to the product.

The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks 
or registered trademarks of HDMI Licensing LLC in the United States and other countries.
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